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Overview of the DO Geographic Information System 
 

The DO GIS model seeks to ensure the easy retention and communication of information about the 
gardens—from design changes over history, to the maintenance of trees, to the exact location of utility 
lines.  The GIS model collates numerous references of survey work done in the garden into one easily 
cross-referenced also preserves the local knowledge of the gardening staff, ensuring that it will be 
passed down to future gardeners and historians. 

 

The Dumbarton Oaks GIS model project was commissioned by John Beardsley, the Director of Garden 
and Landscape Studies, and Gail Griffin, the Director of Gardens and Grounds.  It was undertaken by 
Justin Scherma as a summer intern, aided and advised by Paul Cote. 

 

 

Prior Work 
 

In setting up the new DO GIS model, we drew from the ongoing work of the Alliance of Public 
Gardens GIS (APGG), a consortium of GIS experts at public gardens and zoos led by the University of 
California Davis and including the Missouri Botanical Garden and the Chicago Botanical Garden.  
Quoting from their website, "The ArcGIS Botanical Garden & Zoological Park Data Model is evolving 
free and open source geographic information system (GIS) template for implementing GIS projects at 
botanical gardens, zoos, and similar public landscapes."  This is a unique effort that seeks to utilize the 
existing, well-documented tool of GIS in a fashion that best suits the need of large, complex gardens.  
Consequently, utilizing this data model is a good way of ensuring that those working with this data in 
this future are able to easily understand the structure of the database or add on new features. 

 

Some advantages of using ArcGIS include: 

-proven record 

-readily interoperable and customizable 

-provided for free by Harvard University 

-strong support community and documentation 

-experts from many fields can interact with data 

-fully supports geographic functions 

 

One popular application for organizing data at large gardens is BG-BASE.  Along with an add-on 
application, BG-Map, BG-BASE can display data geographically.  However, the BG-BASE/BG-Map 



combination has drawbacks that might limit its usefulness, being a specialized and simplified set of 
tools primarily for management.  This being the case, institutions where scholarly research often look 
to GIS as a means of keeping management and research information in a common language.  The 
Arnold Arboretum, for example, is currently exploring integrating its existing BG-BASE database with 
ArcGIS.  We believe that given the scale of Dumbarton Oaks and its status as a hub of landscape 
research, an ArcGIS system that readily integrates with basic databases such as Access is a viable and 
appropriate tool. 

 

Conceptual Design of DO Garden Schema: 
Following the UC Davis model, the DO GIS model organizes information according to elevation, 
splitting out in to basic layers by height: 

 

-Utilities:  describes water, electrical, and sanitary lines and outlets, as well as other underground 

installations. 

-Groundplan:  describes the ground surface of the gardens, including paths, buildings, planting areas, 

and lawns. 

-Canopy:  describes the tree cover of the gardens, depicting primary stems and drip line.   

 

Future efforts can yield a more robust system that adds in layers for Shrubs, Herbaceous Plants, and 
Groundcover. 

 

The model also includes information that does not strictly conform to this elevation model: 

 

-Terrain:  current one-foot contour lines for DO 

-CAD:  all pertinent CAD documents in their original form 

-Historic:  historic surveys, plans, and aerial images of DO 

-Context:  information pertaining to the larger DC area 

 

 
DO Cartographic Sources and their Recompilation: 
For the most part, information used in the GIS model is adapted from existing CAD lines.  Since this 
model primarily depicts the current state of DO, the most important plans related to the construction of 
the new library and gardener's building--particularly, those carried out by the landscape architect 
(James Urban) and the civil engineer (Wiles Mensch). 

 

The following is a list of CAD files used in the compilation of GIS data layers: 

 



 

Groundplan/Utilities 
-57501-sbDO-EXCOND (areas unaffected by recent construction) 

-57501-sDO-SITEPLAN (area around new library and utilities around gardener's building) 

-31402-TUNNEL-KEYPLAN (additional utilities details) 

-DOG base current v2008_by_layer (new areas around west of DO) 

 

Canopy 
-DOG base current v2008_by_layer 

 

Terrain 
-DOG base current v2008_by_layer 

-57301 suDO-MASTER v97a (labels some contours ambiguous in DOG) 

 

In each case, the layers were analyzed for content and assigned appropriate feature class in GIS (i.e., 
"groundplan_edge," "terrain," etc.), as well as more specific feature type ("wall," "fence," "tree").  The 
resulting table was then filtered into different layers, with feature classes becoming the basis for the 
final GIS layers.  Extraneous or contradictory information was thus filtered out; unneeded remaining 
elements were manually removed. Missing features were manually added. 

  

In addition, spatial information had to be added to allow the various elements to line up correctly; some 
CAD plans had to be manually georeferenced in order to fit. 

 

Similarly, historic maps were manually scaled and georeferenced in order to best fit the existing data.  
The black-and-white aerial1georef dates from the late 1960's (exact date unknown) and was found in 
the DO archives.  (This was the only straight-on aerial image that could be readily found in the 
archives.)  33364246.tif and 40112964.tif are taken from Washington, DC public GIS files, as are the 
layers included in the DC folder. 

 

 

The Organization of Files 
 

Work: 
The master folder for the entire GIS. Every time you want to do a full backup, you should zip the entire 
“Work” folder and save it on a stable medium. 

 

 



DC: 
“Work” contains two subfiles. “DO” contains any material specifically relating to Dumbarton Oaks (the 
vast majority of the information), while “DC” contains DC-wide information. The four folders in “DC” 
each contain information from a different source. 

 

 HGL: Harvard Geospatial Library. Historic maps of DC from Harvard's collection. 

 

 NCPC: National Capitol Planning Commission. Various maps of DC features including trees, 
 open spaces, streets, etc. 

 

 NPS: National Park Service. Areas under NPS supervision. 

 

 FEMA: Federal Emergency Management Agency. Flood areas for DC. 

 

DO: 
 

Databases: Contains spreadsheets and databases used in day-to-day management and in the prior DO 
GIS system. Unlike the databases contained in the “GIS” folder, these databases are Excel and Access 
documents not native to GIS. 

   

Docs: Miscellaneous documents. Most importantly, in the top level are mxd documents, the main files 
used for ArcMap. The file most work will be conducted, working_copy.mxd, is located here. A 3d 
version of this is also present; DO_3d.sxd opens an ArcScene document. Also included in this file: 

 APGG: Work from the Alliance for Public Gardens GIS, including the documents that we based 
 this database on. 

 map_previews: PDFs of the groundplan and canopy that can be printed and used for 
 breakthroughs. 

 precedents: PDFs of scholarly papers touching on the issues around GIS maintenance of 
 historic/botanical gardens. 

 scherma_presentations: PDFs used for Justin Scherma's presentation of the project in progress. 

 

Drawings: Includes non-GIS maps and graphic material. 

 cad: All related CAD documents, separated by author. “Edited” contains CAD documents edited 
 by Justin Scherma and Paul Cote during the course of the project. “Metadata” contains 
 information on the data included in various CAD documents. 

 etc: Mix of materials with some graphic content. 

 illustrator: AI and EPS files. 

 pdf: Various PDF files. 



 

GIS: Contains the various files and databases used directly in the GIS. 

 doaks: Contains the majority of layers used within the GIS; these have chiefly been generated 
 from CAD documents by Justin Scherma and Paul Cote, and are located within the 
 garden_ms_mdb database. Note that some layers—most notably groundplan_polys_view—
 reside in the scratch folder. 

 doaks_archive: Aerial images obtained from the Dumbarton Oaks Archives. 

 google: Aerial images obtained from Google Earth. 

 scratch: Contains layers and databases used as interim documents during creation of the final 
 GIS. 

 tools: Contains workflow models created by Paul Cote and Justin Scherma 

 usgs: elevation model from US Geological Survey 

  

Tips for a Reliable Filesystem 
Keep the working files on the local hard drive. Working directly with data on network filesystems or 
USB drives is not only slower, but also subject to all sorts of unpredictable behavior.  Back-up to the 
network or your USB drive when you are ready to take a break.  Remember to include any and all 
relevant files, organized in an identical file structure, in your backup—ArcGIS is highly dependent on 
links remaining stable. 

Never begin the name of a file with a numeral—it can cause severe errors that have something to do 
with the assumptions that are made by programming languages.  For similar reasons, don't work in 
folders that have spaces in their names.  This includes the Desktop or My Documents folder. 

 

Workflows: 
Exploring map and identifying things 
You can navigate through the map almost entirely through the mouse:  rolling the scroll wheel to zoom  
in and out, and pressing it to pan.  To identify objects, you can use the Identify button (blue circle with 
an “i”).  This will show you the table of attributes pertaining to the object.   

In order to look more closely at the attributes of all of the objects on a layer, right-click on the entry for 
a layer in the Layers window, and select “Open Attribute Table.” 

Should you close out of the Layers or Tools windows to the left by accident, do not panic—go up to the  
Window menu at the top and turn on “Table of Contents” and “ArcToolbox.” 

 

Changing appearance 
If you want to change the way that a layer looks (colors, line thickness, etc.), double-click on the layer 
entry on the left.  This will lead to the Layer Properties box.  Click the Symbology tab.  Generally, for 
layers composed of lines (such as Terrain) you will want to choose the Features entry in the list to the 
left of the box; this allows to change all of the linework at once.  However, for layers like Groundplan, 
where you want different areas of the same layer to display different properties, you can choose 
Categories → Unique Values.  For example, if you want to display the areas of the Groundplan by their 



material, enter into  Categories → Unique Values, and pull down the Value Field list.  Click on 
“material” and click on the Add All Values button below.  This will populate the white window with all 
of the known values for “material.”  These will each have a randomly-chosen preset color, but you will 
probably want to go through and change the colors to more meaningful values (for instance, red instead 
of green for brick).  Double-clicking on the color swatch to the left of each entry will enable you to do 
that. 

 

Be aware!  One annoying thing about ArcMap is that you can't readily save a symbology.  If you would 
like to go back and forth between seeing Groundplan in terms of “material” and in terms of “f_type,” 
it's probably best to duplicate the layer and have an example of each.  To do that, just right-click on the 
entry of the layer in the Layers window and select Copy.  Then go up to the word Layers (with the 
yellow stack of paper next to it) and Paste.  This will add a duplicate of the layer to the display. 

 

Printing and exporting to other formats 
Exporting your map is fairly simple—go to the File menu at the top, go to Export Map, and select your 
preferred  file type.  To have more control over what is being displayed, go to View→ Layout.  This 
will take to you a screen that works like “Paperspace” in AutoCAD; a piece of “paper” represents the 
boundaries of the printed/exported document and the window on the inside represents how much of the 
parent document you can see. You can change the characteristics of this “paper” in File→ Page and 
Print Setup. 

To specify a scale, double click inside the window; then go to the entry box next to the yellow Add 
Data button at the top of the screen to enter a ratio (i.e. 1:10, 1”=10'). 

 

Editing Groundplan and Canopy 
Every time that you want to change the actual features of the map, you should start an editing session. 
Click the Editor button, which will drop down a list that includes “Start Editing.”  The program will 
then ask which folder or geodatabase you want to edit in.  Select the one that includes the layer that you 
want to alter.  Within that editing session, you will be restricted to the layers included in that particular 
folder or geodatabase.  To change which one of these you are editing, you need to manually change the 
desired layer in the Target drop-down menu; unlike Illustrator, the program won't automatically switch 
when you click on a new layer. 

 

While editing, the two most important icons are the ones just to the right of the Editor button:  the 
Pencil and what Paul Cote calls the Spaceship (looks like a standard cursor arrow without a tail).  The 
Pencil controls creating new features, and the Spaceship selects existing features.  Note that “Pencil” is 
misleading—you can't draw freehand with it.  Instead, like the Pen in Illustrator, it allows you to draw 
lines point by point.  Next to these two icons is the Task drop-down menu.  Most of these can be 
ignored:  you will almost always use “Create New Features” or “Modify Features.”  To the right of the 
Task menu, there are many tools for editing lines:  Split, Extend, and Trim will probably be used most 
often. This area also contains the Target window, which determines which layer you are editing. If you 
are trying to edit and nothing is showing up, this is a good area to check. 

 

Layers can be either point, line, or polygon-based; you cannot have more than one kind of feature on a 



particular layer. Thus, the product you get when you click on the Pencil tool (as well as the drop-down 
list of options next to it) will vary based on the kind of layer you're dealing with. While the Pencil on a 
point layer basically only allows you to place new points, on a line layer it will let you create different 
sorts of lines, and a polygon layer different polygon shapes. 

 

Often, you will want to update or change the information connected to a particular feature.  The easiest 
way to do this is to follow the procedure for opening the Attribute Table (right-clicking on the entry in 
the Layers window).  Select the feature you want to change using the Spaceship tool, and then Show →  
Select—this will narrow down the table to the single record.  If you want to look at multiple records, 
you can shift-select; generally, the attribute table functions like an Excel spreadsheet.   

 

Most of the fields you will want to edit have presets already defined; you can choose the appropriate 
value from a drop-down list.  If you want to change a few records to the same value at once, you need 
to use a tool called the Field Calculator.  Right clicking the field name at the top will bring up a menu 
with options for arranging the data; the Field Calculator will be in the middle.  In the Field Calculator 
box, there will be a number of options for analyzing, ordering, and entering data, but the simplest thing 
to do is simply enter the value that you want the selected fields to have in the text box.  Be aware that 
any difference in wording may lead to lost data, so it pays to be rigorous about spelling and definitions. 

 

After you have made changes, go back to the Editor button and choose “Save Edits”.  Remember, 
especially during a long editing session, save edits AND save your file often.  Like most other 
programs, ArcMap seems more likely to fail the longer you spend working without saving. 

 

Please note that while it is possible to edit some information outside of a formal editing session, you 
will not be able to undo the changes you make! 

 

Adding new layers 
To create an entirely new layer requires a short detour from ArcMap. Open up ArcCatalog, either from 
the Start Menu or by pressing the file drawer icon on the top of the ArcMap window. Once inside, 
navigate the file tree to the left of the screen. You will want to go to work → do → gis → doaks 
→garden_ms_mdb. Inside there, you will see four sub-areas: canopy, groundplan, terrain, and utilities. 
Choose the one that has the most to do with the information you want to input. 

 

Then, right-click on the desired layer, drop to “New,” and select “Feature Class...” This will bring up a 
dialogue box that asks for a name and type (don't worry about an alias). Pick a descriptive name, and 
choose the type based on what kind of drawing you want to make: polygon, line, or point. This will 
create the new feature, which you will then be able to draw on in ArcMap. 

 

Adding new fields to a table 
Adding new fields requires the aid of the Toolboxes. Click the red Toolbox icon at the top of the 
ArcMap screen to bring up a list of Toolboxes next to the Layers menu. Rather than navigating through 
the many toolboxes, use the search tab at the bottom of the window. Search for “Add field.” Double 



click on the entry that comes up, which will bring up a new window. Enter the layer you want to add a 
field to and name the new field. Be aware—like many other places in GIS, if using the table 
somewhere else, it will not let you alter it. Close the table before you try to edit it this way. 

 

Scope of future work: 
Some projects for future interns: 

-maintenance, correction, and editing of data 

-finishing data layers for utilities, shrubs, groundcover, and herbaceous plants 

-scanning and georeferencing Farrand plans and historic maps and surveys 

-incorporating older CAD material as part of a historic survey 

-integrating building plans and information 

-mapping and integrating R Street property 

-mapping Ondine garden 

-creating 3d models of DO 

-creating watershed map 

-outreach to other departments at DO--what could GIS do for them? 

-collaboration with DO fellows in related fields 

-track down and integrate 1937, 1943, ~1950's, and 1966 aerial photos reproduced in Cultural 
 Landscape report 

 

Links for further study: 
http://www.apgg.org/datamodel 

"The ArcGIS Botanical Garden & Zoological Park Data Model is evolving free and open source 

geographic information system (GIS) template for implementing GIS projects at botanical gardens, 
zoos, and similar public landscapes." 

 

http://dcgis.dc.gov/dcgis/site/default.asp 

Official site for Washington, DC GIS data. 

 

http://www.mobot.org/MOBOT/Research/gis/welcome.shtml 

The Missouri Botanical Garden's site for GIS research, including a comprehensive GIS bibliography. 

 

http://www.bg-base.com/ 

Home site for the BG-BASE management software. 

 

http://www.apgg.org/datamodel�
http://dcgis.dc.gov/dcgis/site/default.asp�
http://www.mobot.org/MOBOT/Research/gis/welcome.shtml�
http://www.bg-base.com/�

